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 PowerPoint 2019

Test Your Knowledge  (Page 10)

	 1.	 True	 2.	 True	 3.	 False	 4.	 False	 5.	 True

Topic Flashback  (Page 13)

	 1.	 Remove			   2.	 Rotate left
	 3.	 Increase brightness	 4.	 Decrease contrast
	 5.	 Rotate right			   6.	 Decrease brightness

Art Integration Learning
 (Page 13)

Do it yourself

Quick Quiz (Page 17)
	 1.	 b	 2.	 b

Assess Yourself
	 Choose the correct option.

	 1.	 a	 2.	 c	 3.	 c	 4.	 b

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	

A
Q 	 Answer the following questions: 

	 1.	 Yes, it is possible. Sree should click on the the Remove button.
	 2.	 To open Edit Photo Album dialog box, follow these steps:
	 �	 Step 1:  Click on the Insert tab. 
	 	 Step 2:  Click on the drop-down arrow of the Photo Album tool.

1.
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	 	 Step 3:  Click on the Edit Photo Album option.
	 3.	� The Ink Annotations feature in PowerPoint would be most beneficial for Alex to achieve 

this objective.
	 4.	 To embed the screen activities into a slide, open that slide and follow these steps:
	 	 Step 1:  Click on the Insert tab.
	 	 Step 2:  Click on the Screen Recording tool.
	 	 Step 3:  Click on Select Area button.
	 	 Step 4:  Click and drag on the screen area where the screen activity will be captured.
	 	 Step 5:  Click on the Record button.

	 Scratch Your Brain.
	 1.	 a.  Eraser option		 b.	 Ink Annotations			  c.	 Stop button
	 	 d.  Insert button
	 2.	 Competency-based/Application-based questions:
	 	 a.  Jack can hold the Ctrl key while selecting the photos that are not in order.
	 	 b.  �To make the photograph brighter and increase its contrast, you can use the Increase 

Brightness button to make it brighter and the Increase Contrast button to make the 
colours more vivid.

 Explore in the Lab
Do it yourself

	More on Excel 2019

Test Your Knowledge  (Page 21)

	 a.	 Rows 4, Columns 4
	 b.	 300
	 c.	 109
	 d.	 B4 and C3
	 e.	 D4

Topic Flashback  (Page 25)

	 a.	 F	 b.	 T

Experiential Learning  (Page 25)

Do it yourself

2.
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Interdisciplinary Learning  (Page 29)

Do it yourself

Quick Quiz (Page 29)
	 1.	 b	 2.	 b	 3.	 b

Assess Yourself
	 Choose the correct option.

	 1.	 a	 2.	 c	 3.	 c	 4.	 a	 5.	 d

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	 	 5.	

	 Fill in the blanks with the correct words. 
	 1.	 Select	 2.	 Select All	 3.	 Cut & Paste	 4.	 Fill Color	 5.	 Custom

A
Q 	 Answer the following questions: 

	 1.	� Click on the first cell, then hold the Shift key and click on the last cell in the range. All cells 
between the first and last cell will be selected.

	 2.	� Click on the column header (the lettered label at the top of the column) to select the entire 
column in a worksheet.

	 3.	� To modify the content of a cell in a worksheet Naina should double-click on the cell or 
select the cell and press F2 key to enter edit mode, then make the desired changes.

	 4.	 Use the Copy command (Ctrl + C) to copy the selected data.
	 5.	 To apply a cell style, follow these steps:
	 	 Step 1:  Select the cell(s).
	 	 Step 2:  Go to the Home tab.
	 	 Step 3:  Click on Cell Styles button.
	 	 Step 4: Select the different cell style options.

	 Scratch Your Brain.

	 1.	 a.  W PR A E X TT

	 	 b.  � C L TE YL S L E

	 	 c.   A O LU F LT I
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	 	 d.   W K EO S ER H T

	 	 e.   C LE L

	 2.	 Competency-based/Application-based questions:
	 	 a.   �Vani should rename each worksheet with a more descriptive name related to the data 

it contains.
	 	 b.  �Mary can use the Borders feature in Excel to apply borders to each row and column, 

making the records more identifiable.

 Explore in the Lab
Do it yourself

Periodic Assessment–1
(Based on chapters 1 & 2)

A.	 1.	 Screen Recording:
		�  PowerPoint 2019 allows the user to record the action on the screen along with audio and 

embed the recording into the PowerPoint presentation.
	 2.	 Ink Equation:
		�  The Ink Equation feature of PowerPoint allows the user to write equations using finger or 

stylus (in case of touch screen) and mouse pointer (in other devices). These written equations 
are simultaneously and automatically converted into print form and shown in the Preview 
box.

	 3.	 Merging Cells:
		�  While working on Excel you might need to combine some cells to show a part of data under 

one heading. Combining two or more cells is known as merging.
	 4.	 Photo Album:
		�  The Photo Album feature of PowerPoint allows the user to create a slide show or presentation 

using the photographs or image files selected by the user. The Photo Album may be created 
for personal or professional use.

B.	 4 	 Select Unmerge cells option. 
	 3 	 Click on the drop-down arrow of the Merge & Center button.
	 1 	 Select the merged cells you want to split. 
	 2 	 Click on the Home tab. 

C.	 1.	� From Beginning: This starts the slide show from the first slide.
	 2.	� Screen Recording: It allows the user to record the action on the screen alongwith the audio 

and embed the recording into the PowerPoint presentation.
	 3.	� Ink Equations: the Ink Equations feature of the PowerPoint allows the user to write equations 

using finger or stylus (in case of touch screen) and mouse pointer (in other devices). 
	 4.	� Cell Styles: You can use a cell style that includes a custom border, colours and formatting.
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 Charts, Formulas & Functions in Excel

Test Your Knowledge  (Page 35)

	 Average marks are 90 and Percentage in the exams are 90%.

Topic Flashback  (Page 40)

	 a.  T		  b.  T		  c.  F

Interdisciplinary Learning  (Page 43)

Do it yourself

Topic Flashback  (Page 47)

	 a.  5	 b.  Comp	 c. 7		  d.  CURRENT SYSTEM DATE WILL BE DISPLAYED
	 e.  5	 f.  3

Quick Quiz (Page 47)
	 1.	 b	 2.	 b

Assess Yourself
	 Choose the correct option.

	 1.	 a.	 2.	 d.	 3.	 c.	 4.	 a.	 5.	 b.

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	 	 5.	

	 Fill in the blanks with the correct words. 
	 1.	 Chart Title	 2.	 Formula	 3.	 Range	 4.	 PRODUCT()	 5.	 Logical

A
Q 	 Answer the following questions: 

	 1.	� Gridlines can be either horizontal or vertical lines depending on the selected chart type. 
It makes it easier to read and understand the values.

3.
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	 2.	� Operators are the symbols (+, -, *, /, ^, $, %, etc.) that specify the calculations to be 
performed. 

	 3.	 The final result of the given formula is approximately 5.66.
	 4.	 Any two rules for using functions in Excel are:
	 	 • All Excel functions must begin with = (equal to) sign. 
	 	 • The function name must be a valid Excel name.  
	 5.	 Output: A2 is not greater than A3.

	 Scratch Your Brain.
	 1.	 a. iii	 b. i	 c. ii	 d. v	 e. iv
	 2.	 Competency-based/Application-based questions:
	 	 a. PRODUCT() Function
	 	 b. Mayra should enter the formula in correct form as:

	 	 	 =CONCATENATE(F1,F2) 
	 	 c. UPPER() function
	 	 d. COUNT() function

 Explore in the Lab
Do it yourself

 Digital Drawing in Krita

Test Your Knowledge  (Page 52)

Do it yourself.

Interdisciplinary Learning  (Page 59)

Do it yourself

Topic Flashback  (Page 60)

	 a.  Freehand Brush Tool		  b.  Move Tool		  c.  Rectange Tool

Art Integration Learning
 (Page 63)

Do it yourself

4.
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Quick Quiz (Page 65)
	 1. a		  2. a		  3. a

Assess Yourself
	 Choose the correct option.

	 1.	 c.	 2.	 a.	 3.	 b.	 4.	 c.	 5.	 a.

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	 	 5.	

	 Fill in the blanks with the correct words. 
	 1.	 Install			   2.	 Workspace			   3.	 Dimensions, Content
	 4.	 Brush Presets			   5.	 Size

A
Q 	 Answer the following questions: 

	 1.	� The common options present in the Content tab are Name, Layers, Background Color, and 
Background  Opacity.

	 2.	 The Rectangle Tool is used to draw a rectangle or a square. 
	 3.	� The options available in the Fill list are Not Filled, Foreground Color, Background Color, 

and Pattern.
	 4.	 The Font Family option can help Nitin in changing the font face of his text.
	 5.	� The Freehand Brush Tool is used to draw brush strokes to give an effect of painting to the 

image.

	 Scratch Your Brain.

	 1.	 M
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	 2.	 Competency-based/Application-based questions:
		  a.	 Nitya should use Set Eraser Mode for this task.
		  b.	Sam should use the Letter Spacing option for this.
		  c.	 Neena can import brushes from the Krita Library to solve this issue.
		  d.	� He can select the different shapes tools from the toolbox to draw desired shapes, like 

Rectangle tool, Polygon tool, Line tool, Ellipse tool, etc.
	 	 e.	 Multibrush tool will be helpful to fulfill the task.

 Explore in the Lab
Do it yourself

Periodic Assessment-2
(Based on chapters 3 & 4)

A.	 1.	 Cell reference			   2.	 Workspace			   3.	 Functions
	 4.	 Logical Function			  5.	 Multibrush tool

B.	 Menu bar Color Selector Docker

Toolbar

Toolbox

Status bar

Workspace

Tool Options Docker

Layers Docker

C.	 1.	 Absolute References :	� If you wish to maintain the original references as they were, then you 
should make use of the absolute references.

	 2.	 Mixed References :	� A mixed reference is a reference that refers to a specific row or column. 
It is basically a combination of relative and absolute references.

	 3.	 Relative References :	� In relative reference, you actually refer to cell that is above or below 
and left or right to a number of rows or columns.
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Test Sheet–1
(Based on chapters 1 to 4)

A.	 1.	 c.	 2.	 b.	 3.	 a.	 4.	 a.	 5.	 c.	 6.	 d.
	 7.	 b.	 8.	 c.	 9.	 a.	 10.	 a.
B.	 1.	 	 2.	 	 3.	 	 4.	 	 5.	 	 6.	
	 7.	 	 8.	
C.	 1.	 To open the Edit Photo Album dialog box, follow the given steps:
	 	 Step 1: Click on the Insert tab. 
	 	 Step 2: Click on the drop-down arrow of the Photo Album tool. 
	 	 Step 3: Click on the Edit Photo Album option. 
	 2.	 To embed screen activities into a PowerPoint slide, follow the given steps:
	 	 Step 1: Click on the Insert tab. 
	 	 Step 2: Click on the Screen Recording tool. 
	 	 Step 3: Click on Select Area button. 
	 	 Step 4: Click and drag on the screen area where the screen activity will be captured. 
	 	 Step 5: Click on the Record button. 
	 3.	� Click on the first cell, then hold the Shift key and click on the last cell in the range. All cells 

between the first and last cell will be selected. 
	 4.	 Use the Copy command (or Ctrl + C) to copy the selected data. 
	 5.	� Gridlines can be either horizontal or vertical lines depending on the selected chart type. 

It makes it easier to read and understand the values.
	 6.	 Any two rules for using functions in Excel are:
	 	 • All Excel functions must begin with = (equal to) sign.
	 	 • The function name must be a valid Excel name.
	 7.	� The options available in the Fill list are Not Filled, Foreground Color, Background Color, 

and Pattern.
	 8.	� The Freehand Brush Tool is used to draw brush strokes to give an effect of painting to the 

image.

 Introduction to HTML5 & CSS3

Test Your Knowledge  (Page 73)

a. Home Page	 b. Website	 c. Hyperlink	 d. URL

5.
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Interdisciplinary Learning  (Page 81)

Do it yourself

Quick Quiz (Page 81)
	 1.	 a	 2.	 a	 3.	 b

Assess Yourself
	 Choose the correct option.

	 1.	 a.	 2.	 c.	 3.	 c.	 4.	 b.	 5.	 c.

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	 	 5.	

	 Fill in the blanks with the correct words. 
	 1.	 Markup	 2.	 Empty	 3.	 Body	 4.	 Inline	 5.	 Background-image

A
Q 	 Answer the following questions: 

	 1.	 �HTML stands for Hypertext Markup Language. It is a markup language that describes the 
structure of the web page.

	 2.	� Riya will not get an error while viewing the web page because HTML is not case-sensitive. 
This means that both uppercase and lowercase letters are treated the same in HTML tag 
names.

	 3.	 Somya can use the color property within a CSS style rule.
	 4.	 <!DOCTYPE html>
	 	 <html>
	 	 <head>
	 	   <title>My Web Page</title>
	 	   <link rel=”stylesheet” href=”mystyle.css”>
	 	 </head>
	 	 <body>
	 	   </body>
	 	 </html>
	 5.	� CSS design can also be applied to an HTML document by using <STYLE> tag. This tag should 

be placed inside the <HEAD> and </HEAD> tags. An internal style sheet is commonly 
used when one web page has a unique style.
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	 Scratch Your Brain.
	 1.	 a. HTML5	 b.	 HTML	 c.	 Element	 d.	 Attribute	 e.	 Selector (in CSS)
	 2.	 Competency-based/Application-based questions:
	 	 a.	 Syntax to create a style in CSS is: 
	 		  selector{property1:value1; property2:value2; … …}
	 	 b.	� The problem is that the color value should not be enclosed in double quotes. The correct 

syntax is:
	 		  body {background-color:green} 
	 	 c.	 Avni should press F5 key to refresh the browser.

 Explore in the Lab
Do it yourself

 Internet Services

Test Your Knowledge  (Page 87)

Facebook X Instagram YouTube

Topic Flashback  (Page 90)

	 1.	 Quora	 2.	 Twitter	 3.	 Facebook	 4.	 Skype

Quick Quiz (Page 96)

	 1.	 b	 2.	 b	 3.	 b

Assess Yourself
	 Choose the correct option.

	 1.	 c.	 2.	 a.	 3.	 c.	 4.	 a.	 5.	 a.

6.
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	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	 	 5.	

	 Fill in the blanks with the correct words. 
	 1.	 Facebook	 2.	 Blogging	 3.	 John McCarthy	 4.	 Microsoft	 5.	 iPod

A
Q 	 Answer the following questions: 

	 1.	� Quora was launched in the year 2009, founded by Adam D’Angelo and Charlie Cheever. 
It is a question and answer site where anyone can ask a question and people will answer. 
It provides high quality answers written by different users who share a common interest. 

	 2.	 Any two uses of Skype are:
	 	 • It enables the users to talk face-to-face on video calls to friends and family. 
	 	 • �You can host/hold a video meeting or audio conference with a maximum of 50 members 

at one time.
	 3.	� E-wallet or Electronic wallet refers to a digital wallet that is used to make payments online. 

Before using the e-wallet, we need to add money from the bank account. Most of the 
e-commerce websites provide their e-wallet.

	 4.	 Any two benefits of e-banking are:
	 	 • Convenience of banking
	 	 • Reduced chances of fraud 
	 5.	� Here are two differences between a website and a blog that Sarah can consider while 

choosing the correct platform for each client:

Website Blog

•	 �A website is a collection of static pages 
such as the home page, contact page, 
and profile page.

•	 �A blog contains both pages and posts, 
but mostly posts.

•	 �Websites usually don’t change regularly. •	 �Blogs are based on the idea of orderly 
release of new content to attract a 
crowd.

	 Scratch Your Brain.
	 1.	 a. Travel blogs, Fitness blogs
	 	 b. Google (Google Drive), OneDrive (Microsoft)
	 	 c. Net Banking, E-Wallet
	 	 d. Quora, Instagram
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	 2.	 Competency-based/Application-based questions:
	 	 a.	� To avoid online fraud, each credit or debit card has a three-digit unique secret Card 

Verification Value (CVV) number on the back side of it. The bank also sends a One 
Time Password (OTP) on your registered mobile number to verify the authenticity. 

		  b.	� A newsgroup focusses on a particular topic. The topic is of general interest to all the 
participants in the newsgroup. All participants share their comments and views on 
the topic, while also responding to the comments and views of others. This approach 
facilitates the discussion of a topic. Generally, there is one person, known as News Admin, 
who manages the newsgroup. The News Admin keeps a check on the comments of the 
participants. Before posting comments or articles on the newsgroup page, he decides 
when to stop a discussion and approves them. 

		  c.	 Any two benefits of using Cloud Computing are:
	 	 	 •	 Cost Effective: It eliminates the capital cost of maintaining computing infrastructure. 
	 	 	 •	 �Speed and Flexibility: It allows faster access of resources from anywhere across the 

globe. 
		  d.	 John should use RSS (Really Simple Syndication) to get regular updates from the websites.

 Explore in the Lab
Do it yourself

Periodic Assessment-3
(Based on chapters 5 & 6)

A.	 <!DOCTYPE html>

	 <html>

	 <head>

	 <title>My Name</title>

	 <style>

	 body {

	     background-color: red;

	     color: white;

	 }

	 </style>

	 </head>

	 <body>

	 My name is Amit

	 </body>

	 </html>
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B.	 1.	 OneDrive	 2.	 GooglePay	 3.	 Debit Card	 4.	 Facebook	 5.	 blogger.com

C.	 	 	 	

	 Blogger	 OneDrive	 RSS Feed	 GooglePay

 Algorithmic Intelligence

Test Your Knowledge  (Page 102)

Code:
1 12 5 18 20 27 13 1 10 15 18 27 3 25 3 12 15 14 5
A L E R T M A J O R C Y C L O N E

Experiential Learning  (Page 103)

Do it yourself

Topic Flashback  (Page 105)

	 1.	 b.	 2.	 c.	 3.	 d.	 4.	 e.	 5.	 a.

Interdisciplinary Learning  (Page 107)

Do it yourself

Quick Quiz (Page 108)
	 1.	 b	 2.	 a	 3.	 a

Assess Yourself
	 Choose the correct option.

	 1.	 a.	 2.	 b.	 3.	 d.	 4.	 c.

7.
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	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	

A
Q 	 Answer the following questions: 

	 1.	� The construction of the Algorithm is the stage that requires creative thinking and finding 
the best possible combination of steps to get the result.

	 2.	� Emily should use the algorithm technique for analysing, desiging, documenting her project 
as an algorithm is a set of steps sequentially to solve a problem or to complete a task. 
These steps are the foundation of a program.

	 3.	� The diamond symbol (Decision box) indicates a question or branch in the process flow. It 
is used when there are 2 options (Yes/No).

	 4.	� A Mind Map is a also a problem-solving technique that allows us to organise ideas, thoughts, 
or concepts and their relationship graphically.

	 	� In this technique, we pick up the ideas that have common features. These ideas are then 
grouped under one category, and the different categories are linked to the main topic 
using lines or arrows.

	 Scratch Your Brain.

	 1.	 a.	 Wet the toothbrush.	 3 	 b.	 Apply toothpaste to the toothbrush.� 4

		  c.	 Pick up the toothbrush.	 1 	 d.	 Turn on the tap.� 2

	 2.	 Competency-based/Application-based questions:
		  a.	 She is following the Algorithm technique.
		  b.	 Flow Line shows the direction in which the process flows.

 Explore in the Lab
Do it yourself

 Introduction to Programming

Test Your Knowledge  (Page 115)

	 1.	 T	 2.	 T	 3.	 T

Topic Flashback  (Page 117)

	 1.	 BASIC	 2.	 PASCAL	 3.	 FORTRAN

8.
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Experiential Learning  (Page 118)

Do it yourself

Quick Quiz (Page 119)
	 1.	 b	 2.	 a	 3.	 b

Assess Yourself
	 Choose the correct option.

	 1.	 c.	 2.	 b.	 3.	 b.	 4.	 d.	 5.	 a.

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	 	 5.	

	 Fill in the blanks with the correct words. 
	 1.	 Programming	 2.	 Low-level	 3.	 Machine	 4.	 Fifth-generation
	 5.	 Compiler

A
Q 	 Answer the following questions: 

	 1.	� To communicate with the computers, we need some special languages which are called 
computer languages or programming languages.

	 2.	 Diya should use C++, Java or C# to fulfil her requirements.
	 3.	� Anita should use the fifth-generation languages, that have visual tools to develop a program 

and are easy to use. Examples of fifth generation languages include Mercury, OPS5, and 
Prolog.

	 4.	 Any two disadvantages of High-Level languages are:
	 	 •	 �A high-level language needs to be translated into the machine language by a language 

translator, and thus it wastes a lot of the computer time.
	 	 •	 �The object code generated by a translator might be inefficient as compared to an 

equivalent assembly language program. 
	 5.	� A language translator is software that converts a high-level language program into a 

machine language. There are three types of language translators—assembler, compiler, 
and interpreter.

	 Scratch Your Brain.
	 1.	 extreme → 6 

	 2.	 Do it yourself
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	 3.	 Competency-based/Application-based questions:
		  a.	 John should use Interpreter.
		  b.	 The Fifth-generation language would be the most suitable for Jiya to use.

 Explore in the Lab
Do it yourself

 Python

Test Your Knowledge  (Page 123)

1.	� A low-level language is a programming language that is machine dependent, whereas High-level 
language is a programming language that enables a programmer to write programs that are 
machine independent.

2.	 Python is a high-level programming language.
3.	 Perl and JavaScript are programming languages that are similar to Python.

Topic Flashback  (Page 129)

1.	 Python	 2.	 Interactive Mode	 3.	 Script Mode
4.	 Save option	 5.	 Run Module

Topic Flashback  (Page 130)

Interdisciplinary Learning  (Page 134)

Do it yourself

Quick Quiz (Page 136)
	 1.	 b	 2.	 b

9.
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Assess Yourself
	 Choose the correct option.

	 1.	 d.	 2.	 b.	 3.	 c.	 4.	 b.	 5.	 c.

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	 	 5.	

	 Fill in the blanks with the correct words. 
	 1.	 9	 2.	 Variables	 3.	 Comments	 4.	 Precedence	 5.	 True

A
Q 	 Answer the following questions: 

	 1.	 (10 < -15) → False (10 is not less than -15)
	 	 (2 < 10) → True (10 is greater than 2)
	 2.	� Greater than or equal to operator checks if the value of the left operand is greater than or 

equal to the value of the right operand. If yes, then the condition becomes true. It belongs 
to relational operators category.

	 3.	� Python is Integrated and Extensible Language as we can easily integrate Python with other 
languages such as C and C++. A programmer can write extensions in C or C++ to extend 
Python’s capabilities, especially for performance-critical tasks and these are compiled into 
shared libraries that Python can use.

	 4.	� A prompt is represented by the symbol (three greater than >>>), which indicates that the 
Python interpreter is ready to accept commands. It allows the user to enter commands 
directly into Python and get an output instantly by pressing the Enter key in the next line 
in Prompt itself.

	 5.	� Nothing will be displayed when she presses the Enter key because the symbol # at the 
beginning of the line indicates that it is a comment in Python. Python does not execute 
comments.

	 Scratch Your Brain.
	 1.	 a. 103		  b. True		  c. 7	 d. 111
	 2.	 a. print(“Welcome”)
	 	 b. print(“Result”, result)
	 3.	 Do it Yourself.
	 4.	 Competency-based/Application-based questions:
	 	 a.	� No, the code is not correct. The correct way to assign values to multiple variables at 

once is to use = instead of ==. The corrected code is:
	 	 	 x, y = 10, 20
	 	 	 z = x * y
	 		  print(z)
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	 	 b.	To perform addition Lara should convert the inputs to integers using the int() function.
	 	 c.	� To calculate the population growth of bacteria that doubles every hour, Jiva should use 

the exponentiation assignment operator (**) in Python.
	 	 d.	 Leena can use the NOT operator in Python to reverse the result of a logical expression.

 Explore in the Lab
Do it yourself

 Intelligence and AI Approaches

Test Your Knowledge  (Page 141)

E A R P H O N E

Topic Flashback  (Page 143)

Do it yourself

Interdisciplinary Learning  (Page 144)

Do it yourself

Experiential Learning  (Page 145)

Do it yourself

Quick Quiz (Page 145)
	 1.	 b	 2.	 b	 3.	 b

Assess Yourself
	 Choose the correct option.

	 1.	 a.	 2.	 b.	 3.	 d.	 4.	 b.

10.
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	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	

	 Fill in the blanks with the correct words. 
	 1.	 Artificial Intelligence	 2.	 Linguistic	 3.	 Rule-based
	 4.	 Machine Learning

A
Q 	 Answer the following questions: 

	 1.	� Intelligence refers to the ability to think, to learn from previous experience, to solve complex 
problems and to adapt new things and environment.

	 2.	 The people having musical intelligence possess the following qualities:
	 	 •	 Love singing and playing musical instruments
	 	 •	 Good at thinking in patterns, rhythms and sounds
	 	 •	 Recognise musical patterns and tones easily
	 	 •	 Good understanding of musical rhythm
	 3.	 Rule-based approach
	 4.	� A computer system that achieves AI through a machine learning technique is called a 

learning-based AI approach.

	 Scratch Your Brain.

	 1.	 a.	 Logical-Mathematical intelligence	 b.	 Naturalistic intelligence
		  c.	 Special intelligence	 d.	 Linguistic intelligence
		  e.	 Interpersonal intelligence

	 2.	 Competency-based/Application-based questions:
		  a.	 Spatial intelligence 
		  b.	 Logical-Mathematical intelligence

 Explore in the Lab
Do it yourself

Periodic Assessment-4
(Based on chapters 7 to 10)

A.	 1.	 	 2.	

	 3.	 	 4.	

	 5.	 	 6.	
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B.	 1.	 Data Types: A data type specifies the type of value a variable can contain. 
	 2.	 �==Operator: It checks if the values of two operands are equal or not. If yes, then the condition 

becomes true.
	 3.	 int() Function: It is used to change the input data value into an integer. 
	 4.	� print() statement: The print() function prints or sends the output to the standard output 

device, which is usually a monitor.
C.	 1.	 Make connections between what is being learned and the world outside.
	 2.	 Love exploring the environment and learning about other species.
D.	 �#To accept the marks of five subjects (out of 100) from the user and 

calculate the average.

	 a = int(input(“Enter the marks in first subject: “))

	 b = int(input(“Enter the marks in second subject: “))

	 c = int(input(“Enter the marks in third subject: “))

	 d = int(input(“Enter the marks in fourth subject: “))

	 e = int(input(“Enter the marks in fifth subject: “))

	 total = a+b+c+d+e

	 avg = total/5

	 print(“Average marks: “,avg)

Test Sheet–2
(Based on chapters 5 to 10)

A.	 Choose the correct option.
	 1.	 a.	 2.	 b.	 3.	 c.	 4.	 c.	 5.	 b.	 6.	 a.	 7.	 b.
	 8.	 b.	 9.	 c.	 10.	 d.
B.	 1.	 	 2.	 	 3.	 	 4.	 	 5.		 6.	 	 7.	
	 8.	 
C.	 1.	� The construction of the Algorithm is the stage that requires creative thinking and finding 

the best possible combination of steps to get the result.
	 2.	� A Mind Map is a also a problem-solving technique that allows us to organise ideas, thoughts, 

or concepts and their relationship graphically.
		�  In this technique, we pick up the ideas that have common features. These ideas are then 

grouped under one category, and the different categories are linked to the main topic using 
lines or arrows.

	 3.	 Diya should use C++, Java or C# to fulfil her requirements.
	 4.	� A language translator is software that converts a high-level language program into a machine 

language. There are three types of language translators—assembler, compiler, and interpreter.
	 5.	� A prompt is represented by the symbol (three greater than >>>), which indicates that the 

Python interpreter is ready to accept commands. It allows the user to enter commands 
directly into Python and get an output instantly by pressing the Enter key in the next line in 
Prompt itself.
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	 6.	� Greater than or equal to operator checks if the value of the left operand is greater than or 
equal to the value of the right operand. If yes, then the condition becomes true. It belongs 
to relational operators category.

	 7.	 The people having musical intelligence possess the following qualities:
	 	 •	 Love singing and playing musical instruments
	 	 •	 Good at thinking in patterns, rhythms and sounds
	 	 •	 Recognise musical patterns and tones easily
	 	 •	 Good understanding of musical rhythm
	 8.	� A computer system that achieves AI through a machine learning technique is called a 

learning-based AI approach.


